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Publisher 2003: Introduction�
�
Objectives 

·  Word processor vs. desktop publisher 
·  Creating new documents 
·  Publisher window layout and toolbars 
·  Inserting text 
·  Inserting images 

Word Processor vs. Desktop Publisher 

Desktop publishing refers to using a personal computer to create publications with special layouts, 
text, and graphics such as newsletters, brochures, flyers, catalogs, and Web sites. 
Unlike a word processor, the emphasis of desktop publishing software is on layout and design. 
 
A word processor should be used when creating a document that is mostly text, such as a letter or 
resume.  Graphics can be added to the document but there is a lack of total control over their 
placement.  A desktop publisher should be used if creating documents with many pictures and 
complicated layouts, such as a greeting card or newsletter. There is a great deal of control over 
placement of graphics and text. 
 
Creating New Documents 

You have several options in Publisher 2003 for creating new documents.  They each may be selected 
by clicking on one of the New Publication options listed on the left when you first open Publisher.  
Clicking on each option will provide a menu of publication templates for you to use. 
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Publications for Print- This option provides templates for any sort of printed publication you 
might want.  Some examples include: Flyers, Banners, Brochures, Business Cards, Greeting 
Cards, Calendars, and a lot more. 

Websites and E-mail- This option provides templates for many website and email designs. 
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Design Sets- This option provides sets of different print publication types all sharing the same 
design theme. 

Blank Publications- Blank publication templates for various print and web publications. 

The Publisher Window Layout 
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Text Box- Creates a box for typing plain text.  
Insert Table- Creates a grid for entering text.  
Word Art- Insert specially formatted text. 
Insert Picture- Insert images and Clip Art found on your computer’s hard drive or from a scanner or 
digital camera. 
Lines and Shapes- Allows you to create lines, arrows, and shapes. 
Rotate- Allows you to rotate a frame. 
Move- Allows you to move a frame. 
Resize- Allows you to resize a frame (resize from a corner circle to prevent distortion). 
Fill Color- Allows you to fill in a frame with color. 
Line Color- Allows you to create a line around a frame and color it. 
Font Color- Allows you to change the color of text. 
Ruler- Used to precisely align objects. 
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Inserting Text 

Every element in your Microsoft Publisher document is inside a box or frame, even if you do not see 
the frames printed on the page. 

 
When inserting text into your publication, you cannot simply begin typing onto the document as you 
would in a word processor.  To add text to your document, you have two main options; a text box and 
Word Art. 

Text Boxes- A text box is a box that is used to enter text in a particular location.  All of the text in 
a publication, excluding Word Art, must be contained within one or more text boxes.   

To create a text box, you must first locate the text box button pictured to the left on 
the toolbar located on the left side of the window.  Click on the button a single time.  
This will activate the text box feature.  The text box button should now be 
highlighted. 

To create the text box, first place your mouse pointer over the publication.  You will notice that 
your mouse pointer has become a cross-hair styled pointer.  Left-click a single time on your 
document and hold the mouse button down.  Now, holding the mouse button down, drag the 
mouse pointer diagonally across the page and you will see a box being drawn.  When you feel 
the box is large enough to contain your text, let the mouse button go.  You may now type 
normally inside the box. 

 
 

Word Art- Word Art is specially formatted text that can bring life and color to your publication.  
The Word Art text can have special coloring effects, colored borders, and other special effects 
applied.  Word Art is ideally used for creating headers, titles, and banners.  Below are some 
examples of Word Art: 

 

 
 
 

To add Word Art to your publication, you must locate the Word Art button pictured to the 
left and left-click it a single time.  It should be located on the toolbar situated on the left 
side of the screen. 

The Word Art Gallery should now appear.  From the gallery, select the style of Word Art you 
wish to use by left-clicking on it a single time and then clicking “OK.” 
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Once you have selected your style, a Word Art editing box should appear.  The words “Your 
Text Here” should be highlighted in blue.  This is where you will type what you wish your Word 
Art to say.  Simply begin typing, do not click in the window first.  Remember, Word Art is best 
used when creating headers and titles.  Once you have typed in your text, click “OK.” 

 
 
Inserting Images 

You have several options for inserting images into your publication.  Inserting an image stored on your 
computer or inserting a piece of Clip Art are the two most commonly used methods. 

To insert an image into your publication locate the Insert Image button pictured to the left and 
click on it a single time.  It is located on the toolbar running down the left side of your screen.  

You should now have access to the Insert Image menu that has popped up.   

From the menu you can insert a picture from your computer’s hard drive, 
a piece of Clip Art, an image from a scanner, or an image located on a 
digital camera. 
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Inserting Clip Art 
Select the “Clip Art” option from the menu.  A “Search for:” window should 
appear to the left of your publication.  Simply type whatever it is you wish 
to find a picture of in the search box and click the “Go” button.  Your 
computer will return a list of Clip Art images matching what you searched 
for. 

Once your computer has returned a list of Clip Art images, simply click on 
the Clip Art you want a single time.  DO NOT double-click on the image.  
Your computer will automatically place the piece of Clip Art on your 
publication. 

 

Inserting Images from Your Hard Drive 

Select the “Picture from File” option from the menu.  Your mouse pointer will now turn into the same 
cross-hair style pointer used for creating text boxes.  Drag the pointer across your screen in the same 
manner you would to create a text box.  Once you release your mouse button, the Insert Picture 
window should open.  This window opens to your “My Pictures” folder on your hard drive and allows 
you to browse for images you wish to use. 

 
Click on the image you wish to use and then click the “Insert” button.  Your image should now be 
placed onto your publication. 
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Publisher 2003: Formatting Publications 

�

 Objectives 

·  Manipulating frames  
·  Inserting and deleting pages 
·  Working with lines, borders, colors, and shadows 
·  Publication designs, font and color schemes  
 

 Manipulating Frames 

 

 

Rotating a frame 

Click within the frame 

Move the mouse over the green circle on the top of the frame 
until your mouse pointer changes to a circular arrow symbol.   

Hold down the left mouse key and move the mouse in the 
direction you want the frame to rotate.  You will see an 
outline of the frame appear as you rotate it. 

Let go of the mouse when the frame is how you want it. 

 

 

 

Changing the size of a frame 

Click within the frame. 

Move the mouse over one of the white circles on the outline 
of the frame until the mouse pointer changes to a double 
ended arrow symbol. 

Hold down the left mouse key and drag the mouse in the 
direction you want the frame to expand or retract. 

Let go of the mouse when the frame is the size you want. 

For images, change the size by using one of the circles in 
the corners, unless you want to distort the picture. 
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Moving a frame 

Click within the frame. 

Move the mouse over the perimeter of the frame until the mouse pointer becomes a pair of 
crossed, double-ended arrows. 

Hold down the left mouse key and drag the mouse in the direction you want the frame to move. 

Let go of the mouse when the frame is where you want it. 

 

 

Changing Frame Order 

Click within the frame you want to move forward or backward. 

      Click the “Arrange” menu on your menu bar click on the “Order” option.  A sub-menu will     
appear to the right with four options for you to choose from. 

      Bring to Front - Frame will be in front of all other objects. 

Send to Back - Frame will be in back of all other objects. 

Bring Forward - Frame will be brought forward one level. 

Send Backward - Frame will be sent backward one level. 
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Nudge a Picture/Text 

There are times you want to move an image or a text box by a very small amount and you may 
find that moving it with the mouse is very difficult.  You will find it easier to use the “nudge” option.   

Select the image you wish to nudge by clicking on it once.  If you are nudging a text box, click the 
text box border a single time.   

You now have the object you wish to nudge selected.  Use the arrow keys on your keyboard to 
nudge the object in the direction you wish to movie it.  Each tap of the arrow key should move the 
object a miniscule distance. 

 

  

Inserting and Deleting Pages 
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Inserting a blank page 

To insert a blank page, access the “Insert” menu and select the “Page” option.  A dialogue box 
containing several options should appear.    

 
( 
 � �� 	���� � � � �) � � %�
 � �	
 � � �� � � � �	� � � � �	� +�� �� � � �� � +� . 

You have several options such as indicating if the page is to be inserted before or after the current 
page and the number of new pages to be inserted.  You can also duplicate the object on another 
page. 

When the page is inserted, a small page button with the page number appears on 
the status line at the bottom of the page.  Click on the appropriate button to go to 
that specific page. 

Deleting a Page 

Click on the page you wish to delete and open the “Edit” menu.  Click on the “Delete Page” option.  
The current page will be immediately deleted without confirmation. 

 

 Working with Lines, Borders, Colors and Shadows  

Adding Borders 

You can add borders, line and fill colors and shadows to your text boxes and images. 

Insert a text box or an image with handles displayed. 

Click on the “Line Style”  button on the formatting toolbar and the Line Style menu 
should appear.  Select the style of line you wish to use as a border for your object. 

Adding color to your lines and borders 

Click the “Line Color” drop down menu on your toolbar and a color palette will 
appear.  Select a color from the palette for your line or border.  

Adding a Background Color to your Text Boxes 

Click the “Fill Color” drop down menu on your toolbar and a color palette will 
appear.  Select a color from the palette for your background. 

 



 
 

9 

Adding Shadows to your Text Boxes and Images 

Click “Shadow Style” button on your toolbar.  Select one of the shadow styles from 
the menu for your object.  

Creating a Page Border 

To create a page border in Publisher, you have to be a little creative. 

First, create a text box that encompasses your entire page.  The borders of the text box 
should match the colored guide lines that surround your page. 

Make sure that your new text box is selected. Click the “Line Style” button on your toolbar. 

Click on the “More Lines” option. 

Click on the button labeled “Border Art.”  This will bring up the Border Art window. 

 
Select a border style from the list on the left and preview it in the preview window on the 
right.  

Click “OK.” 

You may find text or other objects disappear after placing a border on a page.  This is 
because the page border is on top on the other objects.  You can fix this by using the 
“Arrange” function and selecting “Send to Back.” 

 

 

 


